
Larry Jordan's Monthly Newsletter - #39 - Sept/Oct 2007

 

Sign up for Larry's FREE 
Monthly Newsletter! 

    

 

Editor: Larry Jordan 
 

Issue #39 - Sept/Oct. 2007 

Welcome to the latest edition of my monthly Final Cut Studio newsletter for September/October, 2007.

The goal of this newsletter is to provide information helpful to the professional user of Final Cut Pro. 
This newsletter publishes each month. Past issues are not archived. However, key articles are posted 
on my website for your reference. All software references are to Final Cut Studio unless otherwise 
noted. 

Please invite your friends to visit my website -- www.larryjordan.biz. We now have over 150 tutorials 
to help you get the most out of Final Cut!
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Welcome

My newsletter is a bit short this month because I'm writing this on the road during our PowerUp Seminar tour (more 
on that in a moment). However, the tour ends next month and I'm looking forward to getting caught up with all the 
email and news.

While I don't have any time this month to write a lengthy tutorial, I do have time to share some of the reader mail I've 
received and a lot of quick tips. 

I'll have more next month.

[ Go to Top. ] 

Get 3 Months of Edit Well FREE!

I'm delighted to announce that Peachpit is offering a FREE three-month subscription to Edit Well for all new 
subscribers.

You read about each issue every month in my newsletter. If you work with Final Cut Studio on a regular basis, you 
owe it to yourself to subscribe.

And now its FREE!

Here's what's in the current issue:

�●     Conforming in Soundtrack Pro 2
�●     A behind-the-scenes look at how the Los Angeles Final Cut Pro User Group works
�●     Reports from editors around the world on how they use Final Cut Studio
�●     A simple technique for saving your Favorites folder
�●     A tutorial on how to use the red, green, and blue curve adjustors in Color
�●     A work-around for saving Motion 3 templates to work in a multi-user environment
�●     Scripting techniques and samples for DVD Studio Pro

Edit Well is already in its second year - and I get comments every month on how helpful it is from editors around the 
world. 

To get your free 3-month trial subscription, click here.

Hurry, this promotion ends Oct. 31. Edit Well is all about Final Cut Studio and, for a short time, it's free!

[ Go to Top. ]
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Michael Horton Now Appearing on LarryJordan.biz

Mike Horton, headcutter of the Los Angeles Final Cut Pro User Group, 
is famous for his "Latest News on Final Cut" so I've invited him to 
produce a special edition just for us. 

If you want to keep up on the latest news about Final Cut, now there's 
even more reasons to visit www.larryjordan.biz.

This Latest News section contains stories, recent technical support 
updates from Apple, new product information, and other interesting 
gossip for the world of Final Cut Studio. The section is updated weekly 
and you can read them by selecting Goodies > Latest News.

 

[ Go to Top. ] 

Changing Function Key Settings

This quick tutorial sprang from a comment Anne Gibson sent. She writes:

If you ever get any info on how to change Exposé so that function keys work properly in FCP, please 
let me know. Right now, I am turning if off every day in Systems Prefs > Keyboard > Mouse. 

Larry replies: Piece of cake. Here are the steps:

1) Go to the Blue Apple > System Preferences.

2) If you are running OS X 10.4, click Dashboard & Expose

2) If you are running OS X 10.3, click Expose
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3) The pop-up menus in the lower left control how the F-keys are programmed. Change them from 
the default F9, F10, F11, & F12 by holding down the Control key and setting them to: Control+F9, 
Control+F10, Control+F11, and Control+F12.
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After that, you won't need to reset them again.

[ Go to Top. ] 

Only 7 Cities Left on my PowerUp Seminar Tour

My PowerUp with Final Cut Studio 2 seminars conclude at the end of October.

So, if you've ever wanted to attend one of my seminars, now is the time. After this tour is over, I'm getting off the 
road for a while to work on some exciting new projects. However, during the next four weeks, I'll be teaching in:

�●     Vancouver - Oct. 5 - 6
�●     Calgary -- Oct. 10 - 11
�●     New York -- Oct. 15 - 16
�●     Boston -- Oct. 18 - 19
�●     Washington, DC - Oct. 22 - 23
�●     Miami -- Oct. 26 - 27
�●     Los Angeles -- Nov. 1 - 2

These seminars have been developed after teaching hundreds of editors all over the world:

�●     Setting Up and Troubleshooting Your Hardware 
�●     Optimizing Your Editing with Final Cut Studio
�●     Mastering Final Cut Studio

Setting Up and Troubleshooting Your Hardware is a four-hour seminar designed to configure your computer and 
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get it running right, selecting the video codec that's best for your project, and discovering the special challenges of 
working with HDV.

Optimizing Your Editing with Final Cut Studio is a four-hour seminar designed to answer three questions: how 
do I get organized, how can I get work done faster, and how to I fix common problems -- like improving my color 
correction -- without calling Tech Support?

Mastering Final Cut Studio 2 is an eight-hour seminar that showcases the new features in Final Cut Pro 6, shows 
how to create effects in Motion 3, illustrates how to improve your audio with Soundtrack Pro 2, and provides a 
detailed tour of Color.

All three seminars allow plenty of time to get all your questions answered. 

Register now - time is running out. This will be my last tour for a long while. Please click here to learn more or 
register.

Acknowledgements

My PowerUp tour is sponsored by: SmartSound Software, Matrox, ProMax, and Video Symphony as Gold-level 
national sponsors, Automatic Duck is a Silver-level national sponsor, and Lynda.com, Digital Heaven, Nattress 
Productions, and PeachPit Press are contributing sponsors.
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Another seminar you might be interested in is HDFest

Marisa Cohen sent me the following info:

HDFEST New York will be taking place October 10th and 11th at the HD theatre at the Sony 
Wonder Technology Lab on Madison Avenue. HDFEST showcases movies exclusively created with 
HD or HDV technology. The screenings include presentations of High-Definition short films, 
documentary films and animation originating from countries around the world including Japan, Seoul, 
Singapore, Germany, England, Ireland, Canada, and Spain. The screenings each night take place 
from 6pm-11pm and tickets are $12. A variety of HD directors, cinematographers, editors and 
animators will be at the event to discuss their work. The complete festival schedule is available at 
http://www.hdfest.com/hdfestnyc.html. Email admin@hdfest.com for additional festival information.

[ Go to Top. ] 

Thinking WAY Outside the Box

Russ Stiggants has found a fascinating use for Final Cut that I have not heard before:

You have a Great E-Newsletter - helps keep us at the bottom of the world - Adelaide Australia to be 
precise - in tune with FCP community.

I thought your readers might like to extend their use of FCP - and their bottom line - by thinking 
beyond the 'visual' 9-dots. FCP is a video edit program certainly, but it's also one powerful audio edit 
suite as well. I am currently adding value to my video library by lifting audio tracks from my 'historical' 
videos (e.g.: sounds from hard-to-get places, and/or 'historical' interviews with people, some of whom 
were experts in their disciplines but who are no longer with us) to make 'oral history' audio CDs. 

http://www.larryjordan.biz/nxltrs/nxltr_39.html (6 of 24) [11/24/07 7:23:58 AM]

http://www.larryjordan.biz/sem/2007_fall_agendas.html#optimize
http://www.larryjordan.biz/sem/2007_fall_agendas.html#mastering
http://www.larryjordan.biz/seminars
http://www.larryjordan.biz/seminars
http://www.smartsound.com/
http://www.matrox.com/video/products/mxo/home.cfm
http://www.promax.com/
http://www.videosymphony.com/
http://www.automaticduck.com/
http://www.lynda.com/
http://www.digital-heaven.co.uk/
http://www.nattress.com/
http://www.nattress.com/
http://www.peachpit.com/index.aspx?rl=1
http://www.hdfest.com/hdfestnyc.html
mailto:admin@hdfest.com


Larry Jordan's Monthly Newsletter - #39 - Sept/Oct 2007

Using FCP 'audio only' import I am bringing in audio stuff from Betacam SP and BVU (admittedly I 
need to go via DV tape, as FCP will not record 'play through' audio/video from Betacam/BVU direct, 
unlike Media 100) - but I end up with a whole bunch of really great audio stuff which I can edit just as I 
would 'visual' pieces - but audio only. As a TV journalist who was first trained in radio, this is one 
liberating experience - I've learnt the value of 'sound' all over again! Not only that, I have a freedom 
that video doesn't give me -- for example, in one important interview with a person who rambled on 
forever, I was able to 'slice and dice' a 20-minute interview into a concise and very listen-able 2 
minutes, without taking away anything from the direction or 'import' of what the subject was saying. I 
could not do that in a video sense (without using the voice with lots of overlay) so I've ended up with 
something very unique from an audio point of view - and very salable, but that's another story 
altogether.

Now there's likely to be many people who say I could do this in an 'audio only' edit suite - Soundtrack 
Pro, Cubase et al - but I find these programs too highly music oriented and not user-friendly for an 
audio-documentary maker (at the same time, let me say that Soundtrack Pro and to a lesser extent, 
GarageBand, are terrific for making 'stings' to highlight a track or to 'close out' a track, just as they 
work in video). FCP gives me great control over sound output (using audio FX and transitions), and 
great control over 'listen-ability' (fades etc). The bottom line is that FCP is great for audio-only editing, 
as it is for video. 

Audio output? Make a .wav file in QT Pro via 'QT conversion' in FCP - then import to Toast 8 - 
'normalize' to ensure your levels are 'normal' for your average CD player -- and Voila! - a CD audio 
oral-history disc which can be very profitable and extend the value of your libraries!

Larry replies: Russ, I agree. I like the way that Final Cut presents audio clips and helps me to get them organized. 
But I had not considered this particular way of using it for audio CDs. Very cool.

[ Go to Top. ] 

Finally, This Tool Has A Purpose!

In my Final Cut Pro 6 - Essential Editing training DVD, I discuss the three different edit selection tools (G, GG, 
GGG) and mention that I couldn't figure out the benefit of the Group Selection tool (GG) -- it seems to do the same 
thing as the Arrow tool.

To relieve my ignorance, Greg Goldman sent in the following:

In the section on Selecting Clips, you say you can't see any difference between the Group Selection 
Tool and the Arrow Tool. Well, the difference is that it's impossible to move a clip with the group 
selection tool, whereas it's very easy to accidentally move a clip with the arrow tool when all you want 
is to select it. Am I right or am I right? Therefore I like to use the Group Selection Tool when selecting 
clips. 

Larry replies: Thanks, Greg, you are right. I've wondered about this tool for years.

[ Go to Top. ] 
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Adding Timecode to a Sequence

Darren writes in:

I'm a subscriber to lynda.com and have been studying your Final Cut Pro training sessions. First, i 
want to say thank you as I've learned a huge amount, so much so that I'm now pursuing a career in 
digital film editing. Anyway, I've come to my first job and I've hit a small problem i need to add a 
timecode slug to the output move that's going to the client. I'm sure I've seen it in the training videos 
but have searched but cannot find it. its for a music video as need it just so the customer can tell 
reference which parts need changing. Thank you in advance

Larry replies: We can do this in about six steps:

1) From the generator menu in the lower-right corner of the Viewer (with the letter A) select Slug.

2) In the Viewer, set the length of the slug to equal your sequence length. If the length is not long 
enough, go to Final Cut Pro > User Preferences > Editing tab and set Still/Freeze Duration to the 
length of your sequence. Then, create a new Slug from the Generators menu (see Step 1).
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3) Edit the slug to the top track of your sequence.

4) Apply Effects > Video filters > Video > Timecode Generator filter. (Note: this is the Generator 
filter, not the Reader filter. The Reader filter reads the timecode of your source clips in the Timeline.) 

5) Double-click the clip to load it into the Viewer, click the Filters tab and change the Hour Offset to 
match the starting hour of your sequence ("0" is the default).
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6) Select the slug in the top track of your Timeline and choose Modify > Composite modes > 
Screen. The timecode is now added to all the clips in your timeline.

7) Output or export. The sequence will need to render, but this process is both simple and fast.

As a side-note: If you need to add timecode to video that's going onto a DVD, and you have the new Final Cut 
Studio 2, you can add timecode using the Timecode filter in Compressor, which saves rendering in Final Cut.

UPDATE - 10/4/07 

Andreas Kiel and Anders Teigen both sent in the following: 

You describe a way to add a TC overlay for a complete sequence. This way is fine, but it could be 
done easier. Just create a new sequence. edit the "playout" sequence into it and apply the TC 
Reader to the nested sequence. 

Larry replies: This works, too. I like the simplicity of the slug, as it avoids any problems with a nest. 

[ Go to Top. ] 

Growing Your Business Training Now Available as a Download

One of the challenges we all face as editors is figuring out how to grow our business. Based on a series of web 
seminars that we did earlier this year, I've developed a new training title called: "Growing Your Business."
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These three 30-minute movies are specifically designed for a free-lance or small business editor and help you:

1) Understand your strengths and weaknesses 
2) Manage clients, time, expectations and money 
3) Improve your job hunting skills 
4) Increase the effectiveness of your marketing 
5) Improve your sales and negotiating techniques.

We've recently created a new version, with improved visuals, which is now available either as a CD or, to save 
freight charges, as three downloadable files.

I've presented this information at several trade shows so far this year, all to very positive reviews. If helping your 
business grow is important to you - these titles can help.

Click here to learn more about the CD version.

Click here to learn more about the download version (3-parts). 

[ Go to Top. ] 

MS Audio Mikes in Final Cut Pro

Phil Ashby, cofounder of the West-of-England Final Cut Pro User Group, sent in the following on a microphone 
style I had never heard of -- the M/S microphone -- which I first learned of last month. 

[Last month you had a question about handling M/S mikes in Final Cut Pro.]

MS (pronounced M S or sometimes M 'n S) is very popular for pro crews shooting in the UK - but 
because it's specialist sound, expensive(ish) mics and generally done via an SQN or similar mixer, it's 
not practiced unless there's a pro sound recordist in the crew. Generally too it's for high-end 
documentaries (many of which don't need 'genuine' stereo from location apart from wild tracks) - 
dramas will need more channels.

Another way of thinking about it is that it's matrixed sound: so M (mid or mono) = (L + R) and S 
(stereo or side) = (L - R) . Think of (L-R) as a difference signal. M-S was originally (I'm talking mid 
80's I think) done with two identical mics and the SQN mixer used to phase invert one of them, and 
supply the two signals for the (Nagra) tape deck, but very quickly the true M/S mic was developed, 
which is as described in the original post from Dave Coulter. The BIG advantage of recording M/S 
was apparent in the 16mm sepmag (sprocketed tape) edit - even slight misalignment of L/R cuts gave 
phase 'shushes' over an edit, not so problematic with M/S systems. And (sub-frame) phase-locking of 
sepmag tape drives was never that stable on playback either, in the dubbing theatre.

The sound has to be de-matrixed during the sound dub - and again as Dave describes, life is made 
much easier for the dubbing mixer, with the ability to adjust the stereo 'presence' via the level on the 
S channel. But to de-matrix, a phase invert filter (or in the physical world, channel!) is required, i.e. 
doing the 'math' : L = (M+S)/2, R=(M-S)/2 - it's the minus S that's the problem.

That's why you can't do it (yet) in FCP - no easy phase invert filter for audio in the mini-mixer.

Larry continues: Thanks for writing, Phil. Bill Southworth then provided some comments:

I just read the question about using MS microphones recorded into FCP. I use a Sanken CMS-10 
extensively and I've spent countless hours searching for a plug-in that would work with FCP or 
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Soundtrack Pro. It is theoretically possible to do the conversion in Logic but I haven't had any success 
doing this.

For a variety of additional reasons, I now use a separate four-channel mixer (Sound Devices 442) 
and it decodes the mic, add it to the mix, and then pass on the mixed stereo to the camera for 
recording. 

If the MS is simply converted to stereo and recorded as stereo on the camera, it CAN BE 
REVERSED later by passing it back through the mixer to turn it back into an MS signal. MS recording 
is a reversible process. A mid-side lobe signal when demuxed is converted to stereo. The stereo 
when demuxed goes back to MS. When you adjust the levels on the MS signal you control the width 
of the stereo image. When you adjust the stereo version you change the left-right balance. So an MS 
mic can be used to focus your zoom in on your subject or discriminate unwanted side noise. 

A plug-in for FCP to mux-demux the audio would be an extremely useful thing for documentary guys. 
I'd buy it in a nanosecond.

Larry adds: Just when I thought we agreed that there was no solution to MS Mikes, Andrew Commiskey sends in 
the following which solves the whole decoding issue.

The decoding process is more mechanical than digital. The mic works by having 2 signals: a middle 
or mono signal and a figure 8 or left-right side signal.

To decode it bring the mid-side (mono) signal into the 1st channel and pan it center, then take the side
(figure 8) make a copy of it and bring it into channels 2 and 3. Pan channels 2 and 3 left and right 
then select the clip on channel 3 and invert it (making it 180 degrees out of phase). This gives you a 
stereo sound field than doesn't cause phase problems when played back mono.

Once again:

�●     Mid-channel - mono center
�●     Side-channel - split to left-right with one of them inverted (or 180 degrees out of phase)

Larry replies: One quick note. Phil is correct that there is no phase inverter for Final Cut. But there IS one in 
Soundtrack Pro. So, if you are mixing in STP, working with M/S mics should be possible.

Thanks to Phil, Bill, and Andrew for their comments -- I learned a lot just reading these.

[ Go to Top. ] 

Too Many Audio Channels

Scott Peterson writes:

I'm using FCS2 and have run into this very irritating problem. Intermittently, 16(!) channels of audio 
are captured/digitized. I capture/digitize BetaSP via RS422 and miniDV via Firewire. In the L/C 
window I figured out how to mute channels 3-16, but what a time-wasting pain in the ass! Is there a 
default to simply capture channels 1-2 every time? This wasn't a problem in previous versions of FCP.

Larry replies: The number of audio channels that are imported are controlled from the Clip Settings tab of the Log 
& Capture window. Make sure the pop-up menu is set to the correct number of audio tracks.
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Also, there were a variety of audio problems in the 6.0 release of Final Cut Pro. Be sure you have upgraded to the 
latest version: 6.0.1 via Software Update.

[ Go to Top. ] 

Quick-Change Audio

Dave Victorson writes:

Your seminar in San Diego was great. I truly appreciate your patience in responding to my questions 
before, during and after each break. Virtually everything was over the top outstanding.

My question: Is there a way to slightly tweak, I mean just slightly tweak a voice so that the same 
woman would sound like a different woman but not a strange woman. I jokingly refer to this as “The 
Madonna Filter.” I don’t need Madonna but just need a housewife to sound like a different housewife.

Larry replies: Yup. Here's how.

1) Select the clip you want to modify in your timeline. 
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2) Apply the Effects > Audio Filters > Apple > AUPitch filter

3) Double-click to load the clip into the Viewer and click the Filters tab.

4) Gently change the Pitch setting until the voice sounds suitably "different." Generally a number 
between 120 and 300 will do the trick -- positive numbers raise the pitch, negative numbers lower the 
pitch.

[ Go to Top. ] 

More Thoughts on HD-DVD and Blu-Ray

Steve MacDonald writes:
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Concerning last month's article on HD-DVD vs Blu-Ray getting more confusing, boy, you're not 
kidding.

I recently took some HDV footage into DVD SP4 and did a HD burn to DVD-R disc, I burned to 
versions one in red laser and one in blue laser. The blue laser burn would not play in a Blu-Ray DVD 
player but the red laser played beautifully in the HD DVD player. Of course, at 4.7GB on a DVD-R 
you won't get much on that disc. I see you can now buy 15GB HD DVD-R media that I'm assuming 
could be burned in DVD SP4. I don't know, for me I think I'm going with the HD DVD format as it just 
seems to be more compatible. And at a $200 dollar price point on eBay it definitely has my attention.

Larry replies: The HD-DVD vs Blu-Ray situation is just a mess. My advice is to experiment as much as you want, 
but avoid both formats for any serious production releases until things settle down and a single standard emerges, 
which I don't see happening for another year at least.
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Follow-on to Using the Extract Filter

Vance Piccin writes:

[In regard to your article last month on using the Extract filter to create alpha channels for a key.]

Last month I learned a new trick for dealing with video tape generated keys. My workflow requires a 
lot of this, but I had never used the Extract filter before. I would always use the Travel Matte-Luma 
composite mode, and make my key adjustments by applying a color correct filter to the key track.

Here is one more step you might want to pass along to Charlie Wilson. As you mention, this work flow 
is designed for a classic television keying style using dedicated video switchers. The graphic artist is 
faced with how to deliver the fill portion of the key. Older analog switchers want to process both the 
background and foreground using the key signal, then add the results. When the artists are faced with 
that situation they output "non-multiplied" foregrounds.

Newer digital equipment has the ability to work with foreground clips that have already been 
processed by the graphic program, or pre-multiplied. The difference is that any transparency, or mix, 
between the foreground and background is handled differently. Setting the video switcher incorrectly 
will cause a composite that has dark or light fringing around glows, ramps and transparency.

Final Cut Pro actually defaults to the older analog standard. When you do the key as you describe, 
both the foreground and background clips are processed and added together. This is fine if the 
original material is not pre-multiplied, but produces a substandard key with pre-multiplied material. If 
you get pre-multiplied elements, you have to got to the item properties and change the alpha channel 
to "black". That switches off the redundant processing of the foreground.

Finally another thought for Charlie. If he uses the same element many times, as it sounds like he 
might with his show open, he can set up the key as you described. Then remove the bottom track, 
keying over nothing. Export a quicktime movie using the animation codec with 100% quality and 
millions+ color. This creates a clip with the alpha all set to go so that he he can just drop it on the 
timeline in one step.

Larry replies: Thanks for this tip, Vance.
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Testimonial for the DH-Fade Filter

Cal Deal writes in with a testimonial for a filter:

I highly recommend the DH-Fade filter. I just did a project with 174 clips, all of which were set up the 
same way. Clip, 5 frame fade, 15 frame black slug, 5 frame fade-in. All I had to do was select all the 
clips, drag and drop the DH_Fade filter, and the fade in/out was applied to all of them instantly. One 
drawback: You can't see the fade in/out in the timeline. But if you change the length of any clip, the 
filter still works properly. No moving of keyframes.

Larry replies: DH-Fade is published by Digital Heaven. You can find more about it here: http://www.digital-heaven.co.
uk/fcplugins/dh_fade.php

[ Go to Top. ] 

A Workflow for the Canon HV20

Justin Ascott started a discussion last month about the Canon HV20 camera and the best workflow to use for HDV.

First, Allan Tépper writes:

I am writing to offer help for Justin Ascott's 24p workflow with the Canon HV20. The 24p recording of 
the Canon HV20 has much in common with the 24p recording of the Sony HVR-V1.

Because of the incomplete way that 24p (23.976p) is recorded with the Sony HVR-V1U (USA NTSC 
model), HVR-V1N (Latin America NTSC model), or Canon HV20 (USA NTSC model), approximately 
16 extra steps are necessary before editing in order to get your 24p footage on a 23.976p (a.k.a 
23.98 or 24p) timeline in FCP. [This is not the case with higher-priced 24p cameras than the V1, since 
they have advanced pulldown.] On the other hand, if you use the 50Hz version of either the V1 or the 
HV20, no extra steps are required before editing, since 1080/25p works directly with FCP, whether 
you capture via FireWire or via HDMI.

I recently published a comparison chart covering progressive HD cameras under US$5k for the South 
Florida Final Cut Pro Users Group. This was in response to many inquiries after they learned 
advantages of progressive over interlaced video. In the process of creating and posting the chart, 
many issues resurfaced about the many benefits of using 25p as opposed to 24p (23.976p) when 
desiring any or or of the following outputs: Film-out, 24p NTSC DVD, full 1280x720 AppleTV 
playback, and SD broadcast tape for either NTSC or PAL.

If you view the comparison chart, which has within itself a link to a new chart which compares the 24p 
versus 25p workflow with these cameras.

To answer Justin Ascott specifically: The FCP Easy Setup called HDV-1080/24p will not work with 
24p footage from the HV20 or the Sony V1. While you have the 60Hz version of the HV20 (and you 
really need a 24p timeline for one of the specified reasons), you'll have to go through the extra 16 
steps mentioned in the chart.

Then, Adam Lloyd Connell sent in the following:

[Regarding] Justin Ascott's question about the Canon HV20:

I have one myself. It is not a progressive frame camera. The sensor records the video which is 
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encoded in NTSC or PAL. The Cinema Mode and the HDV Progressive frame mode can be used to 
create a progressive look, i.e., the look of 24/25p, but the actual signal that is recorded to the tape, 
and then output when you capture in FCP or playback on TV is in fact a standard 60i/50i signal that 
has just been de interlaced. Therefore, to capture whatever footage you have recorded with the 
HV20, you need to use FCPs 1080/50i or 1080/60i preset.

Then, Justin wrote back with more information:

I've recently been using the Apple HDV intermediate codec in FCP 5 with my HV20 rather than 
capturing native HDV because it allows me to preview my edits in the timeline. The image quality is 
still fine for my purposes - better than DV. I intend to use the camera to primarily produce short 
personal films that will be encoded using the Quicktime H264 codec and then uploaded to YouTube 
and my website. I've pimped my camera out with a wide angle matte-box purchased from CineCity in 
India very cheaply (through eBay) and am also using a wireless lavaliere mic bought from B&H. It's a 
great little setup. 

Larry replies: Thanks to all of you for your thoughts. I'm completely ambivalent about the benefits of shooting 24 fps 
material. Just because Hollywood has been shooting film at 24 fps for years doesn't mean this is the best format for 
your video. 

If you are distributing for broadcast, cablecast, or DVD distribution in North America, all TV sets only display 29.97. 
Shooting 24 fps means that all your video will have pulldown frames added to it before it gets displayed on a TV. 

If you are distributing for broadcast, cablecast, or DVD distribution outside North America, almost all TV sets only 
display 25 fps (PAL). Shooting 24 fps means that all your video will need to be slowed down 4% before it gets 
displayed on a TV.

If you are going to the web, 24 fps saves on file size, which is a good thing. 

If you are distributing on film, 24 fps makes the film transfer much, much easier. 

If you are distributing internationally, it is easier to convert from 24 to PAL and NTSC than from any other format.

If you are shooting 24 fps simply because "someone told you that's what all the professionals shoot," I'd suggest you 
consider spending your money on a 1/4 warm black ProMist camera lens filter and improving your lighting, both of 
which will do far more to improve your look than shooting 24 fps.

You are, of course, welcome to disagree.... :-) 

[ Go to Top. ] 

Clever Matrox MXO Tricks

I've been traveling with a Matrox MXO box over the last couple months on my PowerUp tour. After writing about the 
MXO recently, Gino Del Guercio sent in the following on his uses of the MXO:

I found another application for the MXO that I've been extremely happy with.

I recently completed a 90-minute feature doc called Abandoned in the Arctic, which is about the 
doomed Greely expedition of 1881-84, and a modern attempt to recreate Greely's trip. The doc was 
shot primarily with a Varicam in 720p just 400 miles from the North Pole.

For the premier we rented a beautiful old movie house in Portsmouth, NH, called the Music Hall.
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Instead of outputting the doc to tape and then renting a deck to play it, I ran the doc in FCP straight 
out of my MacBook Pro through the MXO and into an HD projector. The doc was projected onto an 
80 foot screen and boy did it look great. The theater was sold out, there was a line a block and a half 
long out the door, and we got a standing ovation at the end. I've included a review.

The tech staff at the theater was very nervous about my running the doc through my laptop, but I 
tested it once through before the show with no glitches. I also had an SD DVD as backup.

So if you think the MXO output looks good on a 23 inch monitor, you should see what it looks like on 
a 960 inch monitor! As we like to say in Boston: wicked awesome.

Andy Mees sends in the following caution, however:

Quick note worth including in your newsletter regarding the Matrox MXO, or worth passing on to your 
reader who is looking to purchase a field editing kit.

The Matrox MXO is NOT currently compatible with the latest MBP, or more specifically its not 
compatible with the Nvidia GPU in these laptops.

"Unfortunately there are some users who have been experiencing playback issues with Apple latest 
Macbook Pro, which seems to be a compatibility issue with Nvidia's new GPU. We are currently doing 
some test with the new MCB and the MXO and will update users of our results. We apologize for any 
inconvenience this has caused. "

Please see full thread here: http://forum.matrox.com/mxo/viewtopic.php?t=409

Larry replies: Thanks for the update. In general, I'm very impressed with the MXO and I'm looking forward to playing 
more in the future.

[Disclosure statement: Matrox is a sponsor of my current PowerUp tour, but even if they weren't, I'd 
still be impressed with this box. You can learn more about the Matrox MXO here.]

[ Go to Top. ] 

More on HDV

Loren Miller, of Neotron Design fame, as well as infamous member of the Boston Final Cut Pro User Group, 
responds to Graeme Nattress' comments on HDV from last month:

[Graeme wrote: Should you convert HDV to DVCPro HD?] No. Never! Why? Adding compression on 
top of compression is just bad. DVCproHD is way too compressed. It's full of artifacts even straight off 
a Varicam. To add that compression on top of HDV just makes a mess.]

Loren replies: 

I disagree. Since a few years ago Boston major market station WCVB's Art Donahue shoots a weekly 
Hi-Def show, CHRONICLE, and transcodes via component out to DVCProHD 720 (editing on Avid) all 
the time, and the philosophy is: "get the signal the hell out of HDV as soon as possible. " 

I saw a show which mixed the result with HDCAM SR-- you couldn't tell which was which. Turned out 
90% of the show-- the B-roll -- was HDV, transcoded. Gorgeous.

This was a SMPTE demo three years ago. HDV hasn't changed since then.
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Larry replies: Loren, HDV is a format filled with challenges. Thanks for sharing this tip. I've been a fan of Chronicle 
since it started in the mid-80's.... sad to see they are still stubbornly editing on an Avid.

[ Go to Top. ] 

Problems with AVCHD Files

Rob Fiedler sends in the following caution when using AVCHD files:

I'm having problems capturing AVCHD files. Everything works correctly up to and including opening 
the Log and Transfer window. It displays the USB connected camera. And I can play the AVC video 
and audio on the viewer. But when I move a file into the transfer window, FCP crashes with no other 
explanation then "...program has unexpectedly quite"

[This was seconded by another user on Creative Cow:] 

I am now having the same problem. Log and Transfer crashes or just simply won't recognize the 
Panasonic AVCHD file structure, so no files appear.

Larry replies: Remember, that AVCHD is only supported on Final Cut version 6.0.1 or later. Also, that it must still be 
transcoded from AVCHD into another format - such as the Apple Intermediate Codec or ProRes.

However, I'll post your comment and see if anyone else has any ideas.

[ Go to Top. ] 

Improving Quality on 8mm Film Transfers

Last month, Malcolm McClure asked for help improving the look of 8mm film transfers of historical footage. A 
reader sent in the following and, for some inexplicable reason, I lost their name - for which I apologize. But the 
comments are excellent so I'm sharing them with you now.

I have doing 8 and super 8 mm transfers for almost 20 years now and here are some of my 
observations. 

�●     Aiming a camera at movie screen can give a better image that a cheap telecine. (White walls 
are not white and don't work). 

�●     A variable speed projector is important as some regular 8 was shot at 18 frames a second, 
some at 24, and some at who knows.. 

�●     99% are home movies shot by amateurs and some time there is nothing you can do. 
�●     Don't trust old edits, always run the film on an editor before you project it. Have lots of editing 

tape ready. 
�●     DO NOT use liquid cleaners, some film stock will get washed away. 
�●     If you can't get a 5 blade shutter projector slowing down the shutter speed will eliminate flicker. 

Most important: There is no magic bullet that will fix color problems. [Larry was] right to say "Final 
Cut's Color Corrector 3-way filter can significantly improve color and contrast," and some times you 
have to do it shot by shot.

But these are family memories, so who cares if grandma's hair is a little green. A slow-mo and the 
right music and you have gem that will be remembered for as long as the DVD format exists.
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Larry replies: Thanks for writing - I'm sorry I lost your name. But I'm still grateful for your reply. 

[ Go to Top. ] 

Capturing Multiple Cameras to One Mac

Jeremy Andrews writes:

I've been asked to set up a video system in a dental operatory to record the dentist performing 
procedures and a piece of dental equipment. I've looked at medical cameras and they are very 
expensive (approx. $8000) and too involved. One medical camera is operated by remote and feeds 
into a DV recorder which takes DV tapes. The dentist doesn't have time to load tapes or adjust the 
camera. They're a very busy practice with high patient turn over. Two camera systems will be needed 
to record patient with doctor and then the equipment. To expect the dentists to do all that is required 
to record a procedure in just not practical.

So, is there a way of capturing two streams of video through firewire on one mac using either 
quicktime pro or another simple to use piece of software?

Larry replies: Yes, however, it took the suggestions of several readers to figure this out: Capture Magic.

Jeremy wrote back:

Capture Magic by bigmugsoftware is just that… magic. It's precisely what I needed. I've hooked up 
my two canon GL2's to a macbook via a firewire 400 repeater. It's amazing, no dropped frames or 
anything, just plug and record. It even works with apples front row remote control so the doctor 
doesn't have to fumble with the key pad with rubber gloves on. It works so well that I'll be setting up 
the same system in another operatory for his associate.

Larry adds: You can learn more about it here: http://www.bigmugsoftware.com/

[ Go to Top. ] 

Problems between iMovie and Final Cut Pro

Taylor Barcroft writes:

[I was having major problems capturing.] Turns out FCP is INTOLERANT of iMovie being open at the 
same time it is. My capturing problem evaporated when I quit iMovie.

Trouble is I like iMovie better for what I am doing. That may sound crazy, but with the new iMovie 
7.0.1 I can place a much more sophisticated looking lower third in a minute than I can in FCP in 15 
minutes.

Larry replies: Fascinating. Weird, but fascinating.

[ Go to Top. ] 

Looking for a Few Good Decks
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Joe Winston writes:

I am working on a feature documentary which was shot 24P Advanced with Panasonic cameras (first 
a DVX-100A then an HVX-200 in tape mode.) I'm generally happy with the results, but I find I have 
technical issues that don't arise with vanilla 29.97 DV.

My Sony DSR-11, which is generally an adequate deck for capturing DV and DVCam, sometimes has 
real troubles with 24p footage (I get "breaks" in the footage while removing advanced pulldown.)

I'm wondering if you or your readers care to make recommendations on good DV/DVCam decks to 
use for Final Cut Pro editing when using 24P footage.

I'm thinking about the Panasonic AG-DV2500.

Larry replies: All good questions... anyone have any suggestions?

[ Go to Top. ] 

In Need of a Universal Output Format

Wendy Bancroft writes:

I've been searching your site looking for information about this because I'm sure it's something you've 
dealt with many times but anyway, can't find anything so here goes:

I want to be able to approach broadcast outfits with my pieces. What format is considered acceptable 
for broadcast these days? e.g. if I'm shooting with a camera that shoots 1080i, (and not e.g. 720p) is 
that acceptable? Would I need to output to another format for broadcast?

Larry replies: Wendy, it isn't that easy. Some outlets want 1080i (CBS, NBC, and Discovery Channel), some want 
720p (ABC & Fox). The ONLY thing to do is contact each outlet individually and ask what their preferred video and 
delivery formats are. 

My suggestion is that if you know you want to go to professional distribution, convert your HDV footage to ProRes 
(ideally during capture), then edit in the ProRes format. If you are shooting DVCPROHD, or XDCAM, edit in that 
format. In all these cases, export a file that matches your sequence settings.

If you are working in HDCAM, or HDCAM SR, consider down-converting to ProRes during capture. These formats 
are robust enough to successfully support an off-line/on-line workflow. 

Once you've determined who's going to distribute your work, convert your exported file to match the format required 
by the distribution channel.

If other readers have differing opinions, I'm interested in hearing what they have to say on this issue.

[ Go to Top. ] 

Finding a Clip!

Christian Johnson writes:
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If I use just the video part of a clip, i.e. as an insert or b/roll and then decide to call up the audio to 
include also, how do I do it without having to go back to search the original footage, is there a 
command that retrieves the audio track or re-links it_

Larry replies: Thanks for writing! Put your playhead in the clip you want to locate and type the letter F.

If the clip is on a track OTHER than V1, then before pressing F, option-click the gray Auto-Select button for the track 
containing the clip you want to locate (the buttons are on the left side of the timeline).

The clip you want is loaded into the Viewer with matching In, Out, and Playhead position.

If you turned off the Auto-Select buttons, option-click on the same button to turn everything back on again. 

UPDATE - 10/4/07

Nathan Seay and Brendan Cusack both wrote to say:

To avoid messing with the auto-select buttons, you can simply select a clip in the timeline. With the 
playhead parked over the selection, hit F and it will ignore the auto-select buttons (it works with shift-F 
too). This is much faster and easier, especially if you’re interested in an audio track. 

Larry replies: This, too, can work. However, as Brendan points out, this is often not reliable. Using the Auto Select 
buttons works every time. 

[ Go to Top. ] 

Resizing Images

George Kennedy writes:

I resized some photos to 1440X1080 to zoom into in FCP, but for some reason when I import the they 
are resizing to what seems like an 16.9 image.

Larry replies: George, 1440 x 1080 is the native size of HDV. When I wrote my first book, I suggested this image 
size as a good one to use when you want to move around in an image. 

Since I wrote that, HDV came out and appropriated that image size for itself. Rather than struggle to convert the 
image back into a DV format, it's just easier to create it at a different scale. For a 4:3 NTSC image that you want to 
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move around inside, use 1800 x 1350 x 72.

Here's an article you can use to look up other relevant image sizes.

[ Go to Top. ] 

Off-Lining Tapeless Media

P.F. Bentley writes:

Do you have an update to your article Successful On-lining for FCP 6?

I'd like to try the offline in DV/online in HDV (ProRes422 timeline?) workflow on a small project and 
see how it goes for future use. Need to save some hard drive space fast!

Larry replies: The short answer is that I don't recommend an off-line / on-line workflow for ANY tapeless media at 
this point. Especially when you are using HDV where there are significant recapture problems. P2 media seems to 
recapture with fewer problems, but DVCPROHD is already small enough and hard disks are big enough as to not 
warrant the hassle.

If you are shooting HDCAM, or HDCAM SR, downconvert to ProRes HQ and edit in that format.

[ Go to Top. ] 

Wrap Up

I'd like to write more, but my plane's about to leave -- and I still have 30 more reader questions to go. I'll have more 
next month after my tour ends. 

In the meantime, please continue sending me your comments and questions. I love hearing from you and enjoy the 
conversations that develop around these stories.

Also, please take a few minutes and:

�●     Register to attend one of our PowerUP Seminars 
�●     Subscribe to Edit Well - the free 3-month sign-up promotion ends October 31. 
�●     Visit our store and buy something... 

Your support for our seminars and products keeps our website, and this newsletter, free. 

Thanks for all your comments and questions. I love hearing from you because when you share your ideas and 
suggestions, we all learn.

Until next month, take care, and edit well.

Larry
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Legal Notes

The newsletter is free -- but does require a subscription. Please invite your friends to sign up at www.
larryjordan.biz/newsletter.

To unsubscribe, simply send me an email and I'll remove you from the list. This list is not sold, rented, 
or bartered. The only person who knows you are on this list is me.

The information in this newsletter is believed to be accurate at the time of publication. However, due 
to the variety of possible system and software configurations, the author assumes no liability in case 
things go wrong. Please use your best judgment in applying these ideas.

The opinions expressed in this newsletter are solely those of the author. This newsletter has not been 
reviewed or sanctioned by Apple or any other third party. All trademarks are the property of their 
respective owners and are mentioned here for editorial purposes only.

Text copyright 2007 by Larry Jordan & Associates, Inc. All rights reserved. This newsletter may not be 
reproduced or published in any way, in whole or in part, without specific written permission from the 
author. 

Links to my home page or articles are welcome and don't require prior permission. 
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